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About Abstract Plus 
Abstract Plus is a cancer data collection tool developed by the Centers for Disease Control and Prevention 
(CDC) and customized by the Wisconsin Cancer Reporting System (WCRS) to meet state reporting 
requirements.  It is used to summarize medical records into an electronic report of cancer diagnosis, staging, 
and first course treatment. The output of Abstract Plus is an electronic abstract in the format of the North 
American Association of Central Cancer Registries (NAACCR) data exchange layout. 

All records are saved in Microsoft Access and all tables are password protected and encrypted.  All users must 
have a User ID and password to access the abstracting features of the application, and access to 
administrative and auditor functions requires the entry of special restricted passwords. 

System Requirements  
• Microsoft Operating System, Windows 7 or later 

• Memory (RAM): 1-2 GB 

• Microsoft .NET Framework 4.5 or newer 

• 70 MB hard drive space 

Downloading, Installing, and Upgrading Abstract Plus 

See the WCRS Abstract Plus webpage, which contains links to CDC ShareFile sites where you can download 
setup files, and installation instructions for Abstract Plus – both Fresh Installs and Upgrades. 

User Support 
For technical support via e-mail, contact WCRS at DHSWCRSdata@dhs.wisconsin.gov. Issues outside the 
scope of WCRS user support will be directed to CDC Registry Plus Technical Support.  

Frequently Asked Questions 

Help! My organization uninstalled my Abstract Plus/reimaged my computer and I have lost all of my 
abstracts. 
First, contact your IT department and see if your backups are saved to a network drive or if you can restore 
your computer to an earlier point in time.  If you are still unable to locate or retrieve your backups, email WCRS 
at DHSWCRSdata@dhs.wisconsin.gov and CC the appropriate parties in your IT department. 
After further review, if it is determined that your backup has been erased and there is no way of recovering it, 
WCRS can provide information on abstracts we have received from you. The format and type of information we 
provide is dependent on individual needs and circumstances and we will work with you to restore necessary 
data as possible. 

I can’t login to Abstract Plus after upgrading to the new version. 
The most common reasons users cannot login is because they had the old version uninstalled and did a fresh 
install of the new version, or because the databases containing user information are in a location the 
application does not recognize. For help, email WCRS at DHSWCRSdata@dhs.wisconsin.gov and CC 
appropriate parties in your IT department if necessary.  

I found a bug or have suggestions on how to make Abstract Plus better. Who do I contact? 
If you encounter an error message, issue, or bug, take a screenshot of the entire application (as feasible; do 
not include PII/PHI unless you send the email encrypted) and include details on what you were doing when it 
happened, or steps on how to re-create the issue if possible. Including more detail than not is a good rule of 
thumb here. Error messages, bugs, issues, feedback, and suggestions can all be sent in via email to WCRS at 
DHSWCRSdata@dhs.wisconsin.gov 

https://www.dhs.wisconsin.gov/wcrs/reporterinfo/abstractplus.htm
mailto:DHSwcrsdata@dhs.wisconsin.gov
mailto:DHSwcrsdata@dhs.wisconsin.gov
mailto:DHSwcrsdata@dhs.wisconsin.gov
mailto:DHSwcrsdata@dhs.wisconsin.gov
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Logging In for the First Time 
After installing Abstract Plus, if you are the first person to launch the program, you will be prompted to create a 
new user account. The following directions will instruct you on how log in for the first time. 
IMPORTANT: The creation of a user account is enabled only upon initial launch of the program.  If other users 
already exist in your Abstract Plus application (i.e., the program has already been launched and user 
account(s) created), you will need to have an existing user login and create a user account for you. Contact 
WCRS for instructions on how to do this if you do not already know how. 

1. Launch Abstract Plus. Result: The Create/Modify Users window opens.  

 
 

2. Enter your name (Last name, First Name, Middle Initial) in the User Name field, User ID (5-10 
characters), and Initials. Click Add.  

 
3. Result: The Login window opens.  Login with your User ID and temporary password: Welcome1 

Enter your: 
- Name (Last, First, Middle) 
- Desired User ID 
- Initials 

Click Add 
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4. A Password Update message is issued that lets you know you need to change your password. This 

occurs upon initial log in only. Click OK. 

 
5. Result: The Change Password window opens. Enter the temporary password (Welcome1) as the Old 

Password.  Then enter and confirm your new password. Your password must be between 8-20 
characters, contain both numbers and letters, but no special characters. Click OK. 

 
 

6.  Set up three Security Questions. These are used to reset your password if you forget it. Click Submit 
Questions. 

 
7. Result: The Main Window opens, with you logged in as a general user.  

  

Welcome1 

Setup 
Questions 
and Click 
Submit 
Questions  

Welcome1 
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Changing Your Password 
From Within Abstract Plus or the Login Screen 

A. If changing from Within Abstract Plus, select Change Password from the Options Menu.  

 
B. If changing from the Login Screen, enter your User ID, click in the Password box, and then click the 

Change Password. 

 
 
 

Result: The Change User’s Password window appears. In the Change User’s Password window, enter 
your current password in Old Password box. Enter and confirm your new password. Your new password 
must be between 8-20 characters, contain both letters and numbers, but no special characters. 
Click OK.  

 

Possible Errors when Changing Your Password 
1. Old password is incorrect. You must correctly enter your old password in order to successfully 

change it. Check to see if Caps Lock or Num Lock is on and try again. Click OK, and then correctly re-
enter your old password. If you cannot remember your old password, follow instructions for Resetting a 
Forgotten Password. 

2. New passwords do not match.  The new password entered into the New Password and Confirm 
Password boxes must match exactly. Click OK, and then correctly re-enter your new password in New 
Password and Confirm Password boxes. 

3. New password does not meet specified password requirements.  Your new password must be 
between 8-20 characters, contain both letters and numbers, but no special characters. Click OK, then 
re-enter a new password that meets the password requirements. 

Click in the 
Password field  

Click 
Change 
Password  

Enter your 
User ID 

Enter and 
confirm your 
New Password 
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Resetting a Forgotten Password 

1. Launch Abstract Plus, enter your User ID and click in the Password field. Then click Forgot 
Password.  

 
2. Result: The Reset User’s Password window opens. Enter the answer to each displayed question with 

the same answer you provided when you set them up. Click Validate Questions when you are 
finished.  

 
 

3. Result: If you answered them correctly you will be directed to the Password Reset window where you 
can set your new password. Enter and confirm your password, then click Reset Password to submit 
the change. 

 
4. Result: The Login window opens. Login with your User ID and newly created password. 

Updating Personal Security Questions 
1. From the Options Menu, select Update Security Questions. 

 
 

2. Result: The Update User’s Security Questions window opens. Select new questions with answers or 
submit new answers to current questions. Click Submit Questions. 

Click Forgot 
Password 

Click 
Validate 
Questions
 

Enter and confirm 
your New Password 

Click Reset 
Password  

Click in the 
Password 
field  

Enter 
your 
User ID 

Answer all 
Security 
Questions
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Main Abstracting Window 
The Abstracting window is divided into two main sections: coded values on the left, and text fields on the right.  
You can drag the vertical divider bar to resize panes and expand/collapse coded value sections. 

 
Display Types 
The abstracting interface is called a display type.  A display type defines which fields and sections are 
displayed. WCRS has two display types:  1976-2017 Diagnoses and 2018-Present Diagnoses. Make sure 
the right display type is selected before entering the data.  For cases diagnosed before 2018, choose the 1976-
2017 Diagnoses display.  For cases diagnosed 2018 or later, choose the 2018-Present Diagnoses display. 

 

IMPORTANT 
Make sure the right display type is selected before entering the data.   

For cases diagnosed before 2018, choose the “1976-2017 Diagnoses” display type.  For cases 
diagnosed 2018 or later, choose the “2018-Present Diagnoses” display type 

Expand and Collapse Fields  
Using the + and - Signs 

Drag dividers to 
Resize Panes 
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Abstracting in Abstract Plus 
Creating and Saving Abstracts 

1. Select New Abstract from the File Menu or click New on the toolbar.  

 

2. Result: A new abstract opens. Ensure you are in the right Display Type according to diagnosis year. 
The available display types are 1976-2017 Diagnoses and 2018-Present Diagnoses.  

 
3. Remember to Save your abstract periodically. To save an abstract, press Ctrl+S or click Save on the 

toolbar. Result: The Abstract is saved, and an Abstract Reference ID is assigned. Edits automatically 
run. See: Running Edits and Fixing Errors for more information on edits. 

Check the 
Display Type 

before you 
start! 
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Helpful Tips for Abstracting 

• For detailed information on reporting requirements, data items, and coding instructions, refer to the 
WCRS Manuals and other Coding Resources when abstracting. 

• Many data items offer code selection from drop-down lists.  These lists feature an auto-complete, find-
as-you-type function. To use this, type in the first letter(s) of the desired item, and the application will 
jump and select the first item that matches. In the example below, “A” was typed into the Race 1 field, 
and the application jumped to American Indian.

 
• For data items with extensive listing of coded values, such as primary site, you can look up valid 

values. To look up values, click on the magnifying glass icon to the left of the data item (or press F4) 
to use the search feature. 

  
• When you look up valid values, you can enter a full or partial search term or code to search for, and 

then double-click on the code of your choice to select and enter the value in the abstract. 

 
• When entering text, a blue progress bar is displayed indicating how much space is left so that you can 

properly prioritize the information you are entering. See the WCRS Data Dictionary for Text Field 
Recommendations and Requirements. 

 
• The Schema ID field is a calculated field which is derived upon clicking the calculator icon next to the 

field. The field will only be derived if all necessary information is coded in the abstract. Schema ID can 
usually be derived by date of diagnosis, primary site code, and histology/behavior code alone, but 
occasionally, other factors are required such as sex, age, schema discriminators, and grade clinical. 

 
• Keyboard shortcuts are available for some useful functions: 

• Save Abstract: CTRL + S 
• Run EDITS: F8 
• Undo: CTRL + Z 
• Cut: CTRL + X 
• Copy: CTRL + C 
• Paste: CTRL + V 
• Select all text in field: ALT + A 
• Move to next field: Enter or Tab 
• Move to previous field: Shift + Enter or Shift + Tab 

  

https://www.dhs.wisconsin.gov/wcrs/reporterinfo/manual.htm
https://www.dhs.wisconsin.gov/wcrs/reporterinfo/coding-resources.htm
https://www.dhs.wisconsin.gov/wcrs/reporterinfo/manual.htm
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Running Edits and Fixing Errors 
For helping resolving Edit Errors, contact WCRS at DHSWCRSdata@dhs.wisconsin.gov.  

For any abstract you can run and view edits errors by saving the abstract, clicking EDITS on the toolbar, or 
pressing F8. Each time an abstract is opened or saved edits are run for accuracy and completeness. All edit 
errors need to be resolved to complete an abstract.  
You can view edits for individual fields or the entire abstract. To run edits on the full abstract, click EDITS on 
the toolbar, or right-click on the abstract and select Run EDITS. To view edit errors for individual data fields, 
right click on the field and select Edits Information.   

 

When you run edits, the Edit Set Results window will open and display information for edit errors that exist, or 
let you know that there are no errors.  To resolve edit errors you can click on the link to the field in the edit 
report, which will navigate you to the field in question.  You can click Show All to switch from viewing edits for 
an indiviudal field to viewing edits for the entire abstract. As you correct errors you can click Refresh to update 
your results.  

The EDITS Error Count and Completion Status indicators are located at the bottom of the abstracting 
window and reflect the current edit error count and completion status of the abstract.   
 

If there are any errors within the abstract, both of these indicators will display in red. 

 
 

Once edits have been corrected, they will turn green. 

  

Click links to navigate to 
field and correct errors 

Refresh results after 
correcting errors 

Right-click and 
select Run 
EDITS to view 
edits for the full 
abstract 

View edit errors 
for entire abstract 

Right-click on a specific field and 
select Edits Information to see 
edits for that field 

mailto:DHSWCRSData@dhs.wisconsin.gov
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Find and Open Abstracts 

1. Select Open/Find Abstract from the File Menu or click Open on the toolbar.  

 

2. Enter your search criteria and click Query. Result: A list of abstracts that meet your search criteria are 
listed.  

 
 

3. From the abstracts listed, locate the abstract of interest and open it by double-clicking the row for the 
abstract or by clicking the row for the abstract and clicking Select. Result: The selected abstract opens 
in the main window. 

 

  

Click Query 

Specify 
Search 
Criteria 

Double click the 
record or click 
Select to open. 

Select the 
record 
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Copy an Abstract  
1. Make sure that you have the abstract to be copied open in the abstracting window. Click on the File 

menu and select Copy Abstract or click Copy on the toolbar.  

 

2. Result: The Copy Abstract dialog opens and asks you to confirm that you would like to copy the 
abstract. Click Yes to copy the abstract (patient demographics) into a new abstract.  

 

3. The abstract is copied to a new Abstract Reference ID. Patient demographics from the original 
abstract are copied over. No tumor information is copied over. 

 

Demographics from 
the original abstract 
are copied to the 

new abstract. 
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Abstract Management 
Importing Abstracts 
You can import complete and incomplete abstracts in NAACCR format.  

1. Open the Import Abstracts window by clicking the Import Icon on the toolbar or by selecting Import 
Abstracts in NAACCR Format in the File Menu.   

 
2. Result: The Import Abstracts in NAACCR Format. Click the Select File and navigate to the files you 

want imported. Click Import. 

 

  

Then Import 

First, Select File 
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Exporting Abstracts  
You need to export your abstracts in order to submit your data to WCRS. Once they are exported, they can be 
uploaded to Web Plus.  

1. Click on the File menu and select Export Abstracts or click Export on the toolbar.  Result: The 
Export Abstracts window opens and presents you with different options for exporting abstracts. 

 

2. Choose your export options and click Select. Result: The system displays the number of abstracts that 
meet the export criteria in the lower left-hand corner of the main window, and in a popup message. 
Click OK, then click Export. 

 

3. Enter a file name for the export file using the specified file naming convention below. Result: The 
system exports the abstracts into a text file provides a report for the export.  

FILE NAMING CONVENTION:  
[5-digit WCRS facility code]_[abstractor initials]_[date exported].xml  

Example: 01005_LAS_20230301.xml 
  

Choose export 
options 
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Creating a Backup 
When logging off and exiting Abstract Plus, the application will prompt you to back up the current abstract 
database. Although you can choose not to back up your database, it is highly recommended that you backup 
your database after finishing a session. Databases should be backed up to a shared network drive if possible. 

1. Exit Abstract Plus. The Exit Program window opens and asks if you are sure you want to exit the 
program. 

 
 

2. Click Yes. A window opens asking if you would like to back up the database containing your abstracts. 
Click Yes to back up the database.  

 

3. Result: The Database Backup window appears. Select where you would like to save the backup if you 
don’t want the backups in the default location.  

 
 

4. Select the desired compression level for the zip file if other than the default. If desired, you may 
password-protect your file. Click Save to create the backup and exit Abstract Plus. ] 
IMPORTANT: If you chose to password-protect your file, the encrypted file cannot be restored 
without the specified password. WCRS does not have access to this password, so if it is forgotten or 
lost, the backup cannot be recovered. 

Use the Search Button 
if you would like to 
select a different 
location for the backup 
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Restoring Abstracts from Backup 
In the event that your Abstract Plus abstracts database (ABSPLUS.MDB) is corrupted, if you have used the 
Backup option to back up your database you will be able to restore your database using the Restore Option.  
The Restore Option allows you to go back to a file that you saved which is why it is so strongly recommended 
that you back up your work when exiting the application. To use the Restore Option to restore your Abstract 
Plus abstract database to an earlier saved backup, complete these steps. 

1. Open the Restore Database window from the File Menu.  
 

2. Result: The Restore Abstract Plus Database window opens. Navigate to and identify the zipped 
backup file on your computer or network by clicking the Folder Icon.  

 
Note: The default location for saving backup files is C:\RegPlus\AbstractPlus\MDBS\Backup. You may 
need to navigate to a different location if you saved your backup file somewhere else (i.e., Network 
drive) 

 

3. If your password protected the selected backup file, enter the password in the Password Box. 
Otherwise just click Restore. Result: The main window opens with the selected abstracts backup 
database restored, and you can resume abstracting activities.  
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Deleting Abstracts  
Abstract Plus allows you to delete abstracts from the abstract database. This feature should be used with 
caution, as abstracts are permanently deleted from the database.  To delete an abstract, complete these steps. 

1. Click on the Utilities Menu and select Delete Abstract(s).  

 

2. Result: The Delete Abstracts window opens. Enter your search criteria and click Query. Select only 
the case(s) you want to delete.  Click Delete. Result: The system verifies that you would like to delete 
the selected abstract(s) and creates a backup.  

IMPORTANT: By default, all cases will be selected. Make sure you deselect any cases you 
want to keep. 

 

By default, all 
cases are 
selected. 

First, deselect any 
records you wish to keep. 

Then, click 
Delete 
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Other Functions 
Doctor Search 
To lookup a doctor you can use the Doctor Query System (DQS). The DQS contains information for 
Wisconsin-licensed Physicians and is updated by WCRS periodically.  

1. Click on the Utilities menu and select Doctor Query System or click DQS on the toolbar. Result: The 
Doctor Query System window opens.  

 

2. Enter the search criteria of your choice and click Query. Result: Doctors meeting the criteria are listed 

 

  

Enter Search Criteria 

Click Query 
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Printing Abstracts or Range of Abstracts 

1. To Print a Single Abstract: Open the abstract you wish to print. Click Print Current Abstract from the 
File Menu. To Print a Range of Abstracts: Click on the File menu and select Print Range of 
Abstracts. Result: The Print Abstracts window opens. 

 

If Printing a Range of Abstracts, Enter the abstract selection criteria for the range of abstracts that 
you would like to print. Click Select. Result: The system displays the number of abstracts that meet the 
selected criteria at the bottom left corner of the window. Then, click Print Preview. 

 

2. Result: The Report Viewer window opens, display the abstract(s) you have selected or specified. You 
can Print or Save the abstract(s) from the toolbar. 

Then, Click 
Select 

First, Enter 
Selection 
Criteria 

Lastly, click 
Print 
Preview 
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Running Reports 
1. To run a report, go to the Reports menu on the toolbar, and select the report of interest.  

 

Report Description 

Accession Register  
Includes a line listing of all abstracts in the 
database, sorted by reporting hospital and 
accession number 

Patient Index Includes a line listing of all abstracts in the 
database, sorted alphabetically by name 

Selected Cases Line listing report which includes abstracts based 
on user-specified criteria 

Status Report (Count of 
Cases) Summary…  

Includes the total number of complete and 
incomplete abstracts by export status within a 
user-specified date range 

Completion Status of 
Abstracts by Month  

Includes abstract completion status by year and 
month of Date of Adm/1st Contact within a user-
specified date range  

2. Result: You will either be directed to a window to specify more criteria, or you will be taken directly to 
the Print Preview of the report. From here, you can Save or Print your report. 
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Setting Default Values for NPI and Facility Codes 
Follow these instructions to set default values for fields. This eliminates the need to look up and enter values 
individually for each abstract.  This is especially helpful for NPI and Facility Codes fields. 

1. From the Administration menu, select Manage Abstract Display Types. Result: The Administrator 
Login window will appear. You will be prompted for a password. Enter Admin.  

 
2. Result: The Manage Display Types window will open. Select the Display Type you wish to configure. 

Then click on the Display Fields tab. 

 
 
 

 
 
 

Select the Display 
you wish to configure 

Click Display 
Fields tab 
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3. Result: The Display Fields tab will open. Select your desired field from the right column and click 
Properties. 

 

4. Result: The Properties window will open. Enter your information (such as WCRS 10-digit Facility ID or 
NPI code) in Field Default Value. Click OK.  

 

5. Result: You are returned to the Manage Display Types window. Click Save. Repeat these steps for 
each Display. When done, the field(s) will be defaulted to your set value in new abstracts you create. 

Highlight the 
field you wish 
to configure 

Click 
Properties 
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